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Quick User Guide for XPS Analysis 

Please refer to “General User Guide” and its table of contents to find details on how to 

execute the following tasks.  When in doubt, discuss your procedure with Dr. 

Lozovyy before proceeding. 

 

1. Your sample and sample plate should be UHV compatible and prepared 

according to UHV requirements (refer to PHI manuals).  

2. Sign in into lab logbook. 

3. Create new platen in software prior to experiment (p. 17). 

4. Load platen (with properly prepared sample(s)) to intro station and follow 

procedure to move platen to the analytical chamber (p. 18). 

5. Navigate to and set up positions for sample analysis (p. 20). 

6. Setup data acquisition protocol (i.e., charge neutralization, Z-alignment, 

sputter treatments, XPS acquisition type, scan properties, positions sequence, 

queue; p. 23,42) 

7. After data acquisition is complete, remove platen from analytical chamber 

followed by intro station (p. 18 – reverse procedure from step 2). 

8. The XPS apparatus, vacuum condition should be at the same condition as prior 

to your experiment.  

9. Transfer data for analysis with MultiPak from primary computer. Facility is 

not responsible for data management. 

10. Sign out in the lab logbook. 

11. Any data published in a manuscript/presented are to acknowledge support 

from NSF DMR 1126394 and Indiana University’s Nanoscale 

Characterization Facility.  Scholarly standards are also to be observed when 

acknowledging contributions from research staff. 
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General User Guide 

This overwview is provided to help you start your XPS experiment, collect data and 

reduce them using SmartSoftware or MultiPack software. 
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Introduction to SmartSoft-VersaProbe 

SmartSoft-VersaProbe is a Windows-based interface with five primary “Sessions” devoted to 

different tasks: 
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 System, for loading and unloading samples or platens; 

This section also includes system control including vacuum and bake functionality; 

 Sample, for locating and selecting analysis positions and SXI imaging; 

 XPS, for acquiring XPS surveys, depth profiles, angle resolved profiles, line scans, 

and maps; 

 Hardware, for Xray-Gun setup, analyzer and detector optimization, depth profile and 

general sample sputtering and charge neutralization. 

SmartSoft-VersaProbe Operator Interface   

 

  

SmartSoft-VersaProbe software’s user interface consists of major interactive areas; 

the Session tabs [each consisting of an Output area and Input area], the Menu bar and 

the Status bar.  Flow across the user interface is from left-right across the Sessions and top-

bottom down the Application tabs. EachSession will reveal corresponding viewers in 

the Output area and unique Application tabs in the Input area. 

Session Tabs 

There is a dedicated section of the manual for each Session with detailed description of 

each Session’s Output and Input areas.  Each section will contain user tasks related to 

this Session.  Sessions can be accessed across the top of the SmartSoft-VersaProbe window 

or through the Menu bar. 

Output Areas 
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The Output area consists of the viewers listed below with the corresponding Sessions that 

use these viewers [refer to the corresponding “Session” section of the manual for detailed 

information regarding each viewer]: 

Camera Viewer                     System 

Chamber Viewer                   System 

Vacuum Viewer                     System 

Platen Viewer                        Sample 

SXI Live Viewer                    Sample 

SEM Live Viewer                  Sample 

Saved Image Viewer             Sample 

Position List Table                Sample 

Spectral Viewer                     XPS [AES] 

Profile Viewer [Line]            XPS [AES] 

Image Viewer [Map]             XPS [AES] 

Tile/Fullscreen: 

Each viewer in the Output area typically can be toggled between a tiled viewer and a 

fullscreen viewer.  Use the Tile/Fullscreen icon in the upper left corner of each viewer 

for this operation. 

Toolbar: 

Each viewer contains a Toolbar area across the top that either will launch a unique task 

or define modes for other interactive operations.  These Toolbars are discussed in each 

“Session” section of the manual. 

Tooltip: 

Hover the cursor over icons [without clicking the icon] to display 

a Tooltip. These Tooltips reveal either names of icons or information related to that icon. 

Context: 

Right-clicking within a viewer will reveal Context menus giving access to other 

operations or Properties windows. 

Input Areas [Application Tabs] 

Each Session contains its own unique set of Application tabs providing control parameters 

related to the tasks.  The Platen Manager Application tab is involved with 

most Sessions and will be located at the top of each Input area.  The Platen Manager is 

discussed in detail in its own section of the manual.  The remaining Application tabs are 

described in detail in the corresponding “Session” sections of the manual.  

Each Application Tab will provide access to commonly used parameters.  Other less 

frequently used parameters or parameters that define default modes of operation can be found 

in the Advanced Properties window.  A button is available at the bottom of 

each Application tab to open these windows. 

Editing Values in Entry Fields:  

Clicking on a field will “insert the cursor” and double-clicking on a field will “select the 

value in the field” allowing the user to perform one of the following editing techniques. 
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Note: hardware will change when Return is selected with the following 

 Insert numbers to the current value and hit Return 

 Replace the value and hit Return 

Note: hardware will change instantly with the following 

 Slew/step the value with the mouse wheel 

 Slew/step the value with the keyboard up/down arrows 

 SPECIAL case paired fields such as X,Y can be slewed/stepped using the 

left-right keyboard arrows for the 1
st
 pair and using the up/down keyboard 

arrows for the 2
nd

 pair. 

Toolbar: 

Some Application tabs contain a Toolbar area across the top that either will launch a 

unique task or define modes for other interactive operations.  These Toolbars are 

discussed in each “Session” section of the manual. 

Tooltip: 

Hover the cursor over icons [without clicking the icon] to display a Tooltip, revealing 

either names of icons or information related to that icon. 

Hover the cursor over entry fields[without clicking the entry field] to display 

a Tooltip, revealing parameter ranges for that field. 

Context: 

Right-clicking within an Application Tab will reveal Context menus giving access 

to Diagnostics windows and Application Log windows.  

The Diagnostics windows provide a further level of control and/or hardware read-backs 

typically for use by service engineers. 

The Application Log windows provide a history of events that are related to 

each Application.  A file will be saved during the current session of SmartSoft-

VersaProbe and four backup copies saved during the last four sessions of 

running SmartSoft-VersaProbe.  All high-level-tasks listed in theApplication Logs will 

be separated by a dashed line.  The combo box at the bottom of the window will allow 

selection of other Logs. 
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The File and Edit menus provide typical MS editing capabilities related to the text in the 

log.  The combo box on the bottom will provide access to other Application Logs.  The 

window can be minimized or closed.  

Acquisition 

This tab will record all pre-acquisition, acquisition and post-acquisition events 

AutoTool 

This tab will record all Queue related events 

E-Neut 

This tab will record any related hardware errors 

GCIB 

This tab will record any related hardware errors 

Image Registration 

This tab will record of Image Registration progress and results 

Intro Camera 

This tab will record any related hardware errors 

Ion Gun 

This tab will record any related hardware errors 

Platen 

This tab will record all platen transfer events 

SEM 

This tab will record all SEM process events 

Stage 

This tab will record all stage, arm, anode and monochromator motor events 

Status Line 

Vacuum 
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This tab will record all vacuum events including subtask operations and 

conditional operations 

X-Ray 

This tab will record emission status and any related hardware errors 

Z-Align 

This tab will record all Z-Align steps and results 

Status Bar 

 

The Status Bar is located below the Input/Output area.  A yellow box will appear around 

the Stage area when the stage is in motion.  . A red box will appear around the Gun areas 

when a communication error has occurred with that device.  The Status Bar provides real-

time display of the following fields. 

 Last acquisition, vacuum, platen or stage control status 

 Current X,Y,Z,R,T positions 

 Xray-Electron gun state (Park, On, Off) 

 E-Neut state (Neutralize, Standby, Off) (Auto Neutralization state) 

 Ion Gun state (Neutralize, Sputter, Blank, Standby, Off)  (Auto Neutralization 

state) 

The Status Bar also provides real-time display for the following options.   

 AES Gun state (On, Standby, Off) 

 UPS state (On, Off) 

 Dual Anode state (On, Off) 

 C60 20kV Ion Gun state (Sputter, Standby, Off) 

 C60 10kV Ion Gun state (Sputter, Standby, Off)   

 GCIB state (Sputter, Blank, Off)   

Context: 

Right-clicking within the “gun” zones of the Status Bar will reveal Context menus 

giving access to re-initialization operations, states of each gun and Auto Neutralization 

states. 

Menu Bar 

The following functions are included in the menu bar: 

File: 

 

Open…: 

This provides an Open dialog box allowing the user to open a datafile. 
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Save Position List and Save Position List As...: 

The Position List Table is automatically saved when the “current” platen is 

changed or when SmartSoft-VersaProbe is exited.  These provide an option to 

save this list at any time. 

Save Workspace: 

The Platen Manager is automatically saved when the “current” platen is 

changed or when SmartSoft-VersaProbe is exited.  These provide an option to 

save this at any time. 

Print Setup...: 

This provides a Print dialog box allowing the user to define the default printer for 

all SmartSoft-VersaProbe print operations. 

Exit: 

Selecting this will safely shut-down the hardware and exit SmartSoft-

VersaProbe. 

Sessions: 

This reveals an extended pull-down list providing access to any Output 

Viewer; Application Tab; and Properties Windows within each Session. 

 

Views: 

This reveals an extended pull-down list providing access to Output Viewers and Viewer 

Properties; customized as a function of which Session is currently open. 
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Data: 

This reveals an extended pull-down list providing the ability to close data files within the 

three data viewers. 

Additional selections include: 

Data>Spectrum>Smooth…: 

 

Smooth Properties provides options related to the Smooth tool in 

the XPS>Spectral Viewer.  Changes will be reflected in the Smooth icon label in 

the XPS>Spectral Viewer and in future smooth operations performed. 

Data>Spectrum>Deconvolution…: 

 
Target Pass Energy (eV): [combo] 

The region data in the Spectral Viewer will be deconvolved to 

this Target Pass Energy. 

[Typically 11.75] 

Peak to Noise Limit: 
The minimum Peak To Noise ratio required to perform the deconvolution 

process. 

[Typically set to 100] 

Iterations: 
The number of Iterations performed in the deconvolution process. 

[Typically set to 50] 

[Choose Iterations * Rate ~ 1 to optimize] 

Rate: 
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The Rate of approach to the solution in the deconvolution process. A 

larger number increases the magnitude of the change in the estimated 

spectrum (at each iteration). 

[Typically set to 0.02] 

[Choose Iterations * Rate ~ 1 to optimize] 

Stop Criteria: 
The relative improvement in the resolution (for each iteration) is 

examined. When the resolution changes are less than this value; the 

iterations are stopped. 

[Typically set to 1] 

Deconvolve: [button] 

Click [depress] or click [un-depress] the Deconvolve button to “use” or 

“not use” this process on subsequent Spectral Viewer displays of region 

data. 

Data>Image>Properties: 

 

Opening this Image Properties while an image is loaded in the XPS>Image 

Viewer will provide information related to that data file. 

Tools: 

 

System Colors...: 

This opens the Color Configuration window providing the ability to select color 

options for the Data Viewers and the Platen Viewer.  Editing these selections 

will take immediate affect. 
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Background: 

This provides a selection for the Data Viewer’s background color. 

Curve 1-20: 

This provides a selection for the Data Viewer’s data color. 

Platen Colors: Platen Caption: 

This provides a selection for the Platen Viewer’s annotation color. 

Position Colors: Position Active: 

This provides a selection for the Platen Viewer’s Active Position color. 

Position Colors: Position Inactive: 

This provides a selection for the Platen Viewer’s Inactive Position color. 

  

Queue: 

Clear Queue: 

This will clear all Queue Jobs from the Queue 

Queue: 

This will open the Queue window 

Help 
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SmartSoft-VersaProbe Help: 

Selecting this will provide access to the .htm User Manual.  The home page for this 

manual provides icon links to the “How To” Procedures, Introduction and 

Overview section; five Session sections; the Platen Manager section and two 

support documents. 

About SmartSoft- VersaProbe …: 

Selecting this will open the About SmartSoft-VersaProbe window. 

 

   

Operation Overview 

Typical operation is performed within the System, Sample, XPS, and/or AES Sessions and does 

not require the user to startup or setup hardware.  Most of this is automated; leaving the user with 

the following tasks: 

 Sample introduction, platen manager setup and capturing photos performed in 

the System Session 

 Analysis area definition, SXI imaging and Z-Alignment performed in 

the SAMPLE Session 

 Acquisition setup, data acquisitions, data review and Queue operations performed in 

the XPS Session and AES Session 

Navigating on the Platen is accomplished using the Platen Viewer and SXI Viewer on 

the Sample Session.  See this section of the manual for detailed description of the following: 

 Coarse XY moves are accomplished dragging the Stage Marker within the Platen 

Viewer.  

 Fine XY moves are accomplished with the Point-n-Click feature in the SXI Viewer. 

 Z-Height adjustment is accomplished with the Z-Align tool in the SXI Viewer and 

with the pre-acquisition Z-Align option in the Acquisition Properties. 

 Compucentric Rotation is accomplished with the Rotate Horizontal tool in the SXI 

Viewer. 

 The “Stage” Application is only needed for manual Tilt changes. 

Vacuum tasks such as Pump/Vent Intro or Pump/Vent Chamber pumping are performed in 

the System>Valves tabs: 
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Vacuum tasks such as sublimation or Baking are performed in Watcher: 

Gun performance tuning or creating new gun settings are performed in the Hardware tabs: 

Analyzer/Detector performance tuning is performed in the Hardware tabs: 

Automated setup is found in the following locations: 

Automated Intro Photo System>SampleTransfer>Properties 

Automated Sputter setup 

XPS>Profile>SputterTable 

XPS>“Application”>AcquisitionProperties>Setup>Pre-

Sputter 

XPS>“Application”>AcquisitionProperties>Setup>Pre-

Sputter 

Automated X-Ray  

setup during  

SXI & SXI Z-Align 

XPS>SXI>SXIProperties>Setup 

XPS>OutputArea>SXIViewer>ContextMenu>Setup 

Automated X-Ray  

setup during Acquisition 
XPS>AcquisitionApplicationTabs 

Automated E-NeutNeutralization setup 

XPS>“Application”>AcquisitionProperties>Setup 

XPS>SXI>SXIProperties>Setup 

XPS>SXIViewer>Toolbar>Context>Properties>Setup 

System>OutputArea>ChamberViewer>E-Neut  

StatusBar>E-Neut>ContextMenu 

Automated Ion GunNeutralization setup 

XPS>“Application”>AcquisitionProperties>Setup 

AES>“Application”>AcquisitionProperties>Setup  

XPS>SXI>SXIProperties>Setup 

XPS>SXIViewer>Toolbar>Context>Properties>Setup  

System>OutputArea>ChamberViewer>IonGun 

StatusBar>IonGun>ContextMenu 

Automated Analyzersettings  

[SXI ,Z-Align  

& Detector] 

Hardware>Analyzer>Properties>Lens 

Automated Ion Gun Differential 

Pumping &Argon Gas Admission 

Hardware>IonGun>IonGun  

Hardware>IonGun>IonGun>Properties>Service 

Automated X-Ray  

Beam Parking 

XPS>“Application”>AcquisitionProperties>Setup 

Hardware>Source>X-Ray>Properties>Service 

Automated  AES>“Application”>AcquisitionProperties>Setup 
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Beam 

Current ReadingBefore AES Acquisition 

  

Settings 

 

Many of the Application tabs include a “settings” area.  A setting is a group of parameter values 

related to the displayed application tab.  The settings area allows the operator to save and retrieve 

parameters as settings for future use. 

NOTE:  Not all related parameters are stored when a setting is created.  Some parameters will 

have the same value regardless of the setting, but can be changed individually by the operator.    

Special Settings: 

The PREVIOUS setting is found in all the setting areas, and will load the setting that was 

active prior to the last system shutdown.  The PREVIOUS setting is updated whenever the 

operator moves to a new session tab or exits SmartSoft-VersaProbe.  

The INITIAL setting is found in settings areas that save hardware 

parameters.  The INITIAL setting is automatically selected when the system is first started 

as it sets the system hardware to safe default parameters. 

Load Settings: 

To select a setting, use the text box to highlight the desired setting, then click Load.   

Note: Selecting and loading a setting with the E-Neut, Ion Gun, C60 20kV Ion Gun, C60 

10kV Ion Gun or GCIB in an OFF state; allows the user to view parameters without 

voltages being applied to that gun. 

Alternatively, you can restore a setting that was used during the acquisition of a specific data 

file.  Data files (Surveys, SXI images, Maps, etc.) generated in SmartSoft-

VersaProbe include information on the settings used during their acquisition.  Click 

the File button in the settings area and then select the desired data file.  The file itself will not 

open, but the settings stored with it will be loaded into the active Application Tab. 

Save Settings: 

To create a new setting, set the parameters as desired.  Type a setting name in the text box 

and click Save.  
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Delete Settings: 

To delete a setting, select it and then click Delete. 

Note: some settings are RESERVED and cannot be deleted. 

 

There are several types of XPS data you can collect: 

1 Survey 

A Survey is one spectrum acquired from a quick, high-sensitivity scan of a wide energy range 

(typically 0 to 1100 eV in 1 eV steps) to survey the elements present at a point on the sample or 

over an area.  In point analysis, a stationary x-ray beam is positioned on a specific 

point.  In area analysis, the beam is rapidly scanned, or rastered, over an area or multiple areas of 

the surface.  

2   Multiplex 

A Multiplex is a set of spectra acquired from a series of high-resolution surveys of narrow 

binding energy ranges (typically 4-31 eV wide in 0.25-1 eV steps).  This type of acquisition 

yields great sensitivity and spectral detail in a short analysis time, because only selected energy 

regions expected to contain XPSpeaks of interest are scanned.  

The more commonly used multiplex acquisition routines are the line and profile. 

3   Depth Profiles 

An XPS Depth Profile provides compositional data as a function of depth.  A sputter depth 

profile consists of a series of spectra that have been collected at different depths as material was 

removed from the sample.  An XPS depth profile is generally made by alternating sputtering 

with data acquisition.  The purpose of a depth profile is usually to verify or determine the 

construction of a thin film structure.  Other applications include studying inter-diffusion of 

layers, looking for impurities in layers or at interfaces, and general characterization of surfaces 

and thin films. Depth profile data can be used to extract chemical state information as well as 

atomic concentration data.  

4  Angle Profiles 

An XPS Angle Profile provides compositional data as a function of depth.  Angle-

Resolved (angle-dependent) profiles are used to probe the near surface region of a sample in a 

non-destructive manner.  Angle Profiles are possible, because the input lens of the 

analyzer (SCA) can operate with a small acceptance angle, and it is possible to tilt the sample in 

front of the analyzer.  The analysis depth at a given angle is defined by the equation: 

d =αsinθ 

 

 
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where d is the effective analysis depth,  

α is inelastic mean free path (escape depth) and  

θ  is the angle between the sample surface and the analyzer input lens.  

Angle Profiles are used typically to measure the thickness or explore the chemistry of very thin 

layers.  Applications include the study of chemically modified surfaces, lubrication, cleaning 

processes, and such. 

  

5  Maps 

A Map is a set of intensity-value arrays acquired over the area of the sample to show the surface 

distribution of specific elements.  Each array of intensity values corresponds to an element, and 

each value in the array corresponds to a point in the map area.  The intensity value is obtained by 

measuring the intensity at a specific XPS peak energy, then subtracting the background 

intensity.   

Acquiring map data for every element identified in the survey will completely characterize the 

distribution of elements in the analysis area.  These maps are then compared to the SXI image or 

platen view. 

6  Line Scans 

An XPS Line scan is acquisition of data along a single line across a sample. The intensity value 

is obtained by measuring the intensity at a specific XPS peak energy, then subtracting the 

background intensity.   

 

Here we provide and overview on first two of XPS data types: Survey and 

Multiplex. We refer to VersaProbeII manulas if you need other data type to collect, but 

any of these starts, as described below, from New Platen creation before introducing 

your sample into analitical (main) chamber. 

Create New Platen 

Creating a Platen is the first step of data analysis.  It should be performed before placing the 

platen(sample) in the intro chamber.  Refer to the Platen Manager section for information 

related to the Create Platen window within the System session. 

1.   Click the Create Platen button on the System>Platen Manager>Platen tab. 

Or Right-click on the Intro Station within the Intro>SystemGlyph and select Create 

Platen 

Note: if at anytime you would like to cancel the Create Platen operation, simply select 

the Cancel button and the dialog box will close.  No platen will be created. 

2.     Enter a New Platen Name 



18 | P a g e  
 

3.    Click OK 

The Create Platen window will automatically close and a new platen(sample) will now 

appear at the Intro Station within the System Session. 

4.     View the System>PlatenManager>Platen application window. 

5.     Select the platen(sample) Type [25mm, 60mm, AR] 

6.     Optional: Select an image overlay if a new Intro station Navigation Photo will not be 

captured for this sample. 

Templates are found in the C:\SmartSoft-VersaProbe\Platen folder  

Other Intro station Navigation Photos are found in C:\Datafiles folders 

7.     Use the default Max Z Height for this type  

or enter a lower value if your samples are raised above the sample holder surface. 

8.     Select a Directory where data will be saved for this sample. 

If a new folder is desired, then click on the root directory and add a \foldername to the end 

of the root directory path in the Directory Name: field 

9.     Click the System>PlatenManager>Platen>AdvancedControl Properties button to edit 

the Filenaming format or the Comment format 

10.  Select the desired automated Filenames and Comments options in the Filename tab. 

11.  Enter desired information in the Contact Info tab. 

12.  Click the Close button when finished with the Platen Manager Properties window 

Attaching/Removing a Platen(Sample) at the Intro Station 

Warning: This task is to be performed during Loading and Unloading a platen(sample) at 

the Intro station and should be performed when the user is prompted to.  

Installing a Platen(Sample) 

1.     Lift the Intro lid.  

2.     Pick up the platen(sample) with a gloved hand or intro tool.  The platen(sample) should 

be oriented with the alignment marker towards the Intro Rod. 

3.     Hold the platen(sample) in front of the intro fork and slide the platen(sample) onto the 

end of the intro fork.  

Removing a Platen(Sample) 

1.     Lift the Intro lid.  

2.     Grasp the platen(sample) with a gloved hand or intro tool.  
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3.     Slide the platen(sample) off the end of the intro fork and remove from the Intro 

chamber.  

4.     When the platen(sample) is removed from the Intro, place the lid on the intro chamber 

to keep this area clean.  

Move Platen(Sample) into Analytical Chamber 

The new platen(sample) should be at the Intro station before performing this task. 

1.     Drag-n-Drop the platen(sample) from the Intro Station to the Stage Station. 

 Or click the Intro Sample [button] on 

the System>SampleTransfer application window. 

  
The Intro chamber will be automatically backfilled to the “atmospheric pressure” 

indicated in the Vacuum Properties Window 

 

2.     Place the platen(sample) on the intro fork 

3.     With the Intro Camera option: 

a.       Leave the lid off 

4.     Click Ok. 

The Intro station Navigation Photo will automatically be captured and saved 

 

5.     Place the lid on the intro chamber 

6.     Click Ok 

The Intro chamber will automatically be pumped-down to the “intro pressure setpoint” 

defined by Watcher. 

TheIntro procedure will then wait for the pressure indicated in 

the System>SampleTransfer>SampleTransferProperties window to be met if the Cold 

Cathode is installed on the intro chamber . 
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Another delay will occur if the Additional Delay (min) box is checked. 

Then the following prompt will appear 

  

7.     Wait if more pumping time is still desired and then click Ok 

otherwise click OK 

The stage will automatically be moved to the transfer position, the Intro Gate Valve 

V1 will automatically be opened and the following prompt will appear. 

  

8.     Slide the intro rod to engage the platen(sample) with the stage and click Ok 

The stage will automatically raise the Z axis by the amount indicated in 

the System>SampleTransfer>SampleTransferProperties window to engage the 

platen(sample) with the stage and the following prompt will appear. 

 

9.     Slide the intro rod out and click Ok 

The Intro Gate Valve V1 will automatically close when the intro rod is completely 

retracted. 

The Stage will move to a centered orientation with the analyzer 

 

Once your sample is in analytical chamber you can navigate. 

 Navigate: Overview 

Stage moves within the Platen Viewer will not always lower the Z axis or level the T axis 

Caution should be taken if a platen(sample) is on the Stage with raised samples.  
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Stage moves within the Sample>Stage tab using the Drive All button will offer this protection 

if the radio button for Protection Drive All is set 

to On within Sample>Stage>StageProperties>Properties>StageProtection. 

Stage moves during an acquisition will offer this protection if the radio button for Protection 

Acquisition is set to On within Sample>Stage>StageProperties>Properties>StageProtection. 

The following are preferred and optimized modes of Stage axis navigation: 

 Lateral navigation should be performed using the Stage Marker within the Platen 

Viewer and Point-n-Click operation with the SXI Live Viewer.  

 Z adjustments should be performed using the Z-Align operation.  

 Rotation adjustments should be performed using the Rotate Horizontal icon within 

the SXI Live Viewer. 

The following navigation methods are available: 

 Multiple axis moves can be performed by editing the X,Y,Z,R,T target fields 

followed by a Drive All using the Sample>Stage tab 

 Z, R or T adjustments can be performed by editing the corresponding target field 

followed by a Drive Z, Drive R or Drive T using the Sample>Stage tab.  

See the Sample session discussion of the manual for further information 

1  Navigate: Navigate using the Platen Viewer Images 

The platen(sample) should be on the Stage. 

Method 1-move stage marker location 

 Grab the Stage Marker and drag-n-drop to a new location on the image 

Method 2-move stage to anywhere in the image 

 Right-click at a desired location on the image and select Drive to Click to 

move to this location 

Method 3-move stage to a Position in the image 

1.     Right-click on the desired Position on the image and select Drive To Position 

or 

1.     Left-click on the desired Position on the image 

2.     Click the Drive To Position icon in the Platen Viewer toolbar 

2 Navigate: Navigate using the Platen Viewer Google Bar 

The platen(sample) should be on the Stage. 

1.     Select the X, Y or Z button within the Platen Viewer Google bar 

2.     Grab the Slidebar and drag-n-drop up/down to a new axis position 

3.     Left-click the Increment Up or Increment Down buttons on the slidebar to step the axis 

4.     Use the Up/Down keyboard arrows to step the axis 
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5.     Return the button selection to Zoom 

3 Navigate: Navigate using the Position List 

The platen(sample) should be on the Stage. 

Method 1 

1.     Right-click within the ID column on a position in the Position List and select Drive to 

Position to move to this position 

Method 2-Use the “Drive To” icon in the Position List toolbar 

1.     L-Click on the desired Position in the Position List to select that position 

2.     Click the Drive To Position icon in the Position List toolbar 

4 Navigate: Navigate using the Live SXI Viewer 

The platen(sample) should be on the Stage. 

Point-n-click Method 

1.     Start SXI imaging 

2.     Select the Zoom icon in the Live SXI Viewer toolbar 

3.     L-Click within the SXI image to move the stage XY to that location 

Drag-n-drop within the SXI image will also restart the SXI imaging with a new field-of-

view defined by the drag-n-drop box and will move the stage XY to align to the center of 

the drag-n-drop box 

Rotate Horizontal Method 

1.     Start SXI imaging 

2.     Select the Rotate Horizontal icon in the Live SXI Viewer toolbar 

3.     L-Click within the SXI image to define the new “centered” location 

Drag-n-drop a line within the SXI image defining a desired horizontal orientation 

Note: L-click only will perform a point-n-click operation 

5 Navigate: Navigate using the Stage Tab 

The platen(sample) should be on the Stage. 

Single Axis Moves 

1.     Edit the Target Position of a single axis 

2.     Click the Drive button for that axis 

or 

1.     Select the Target Position field for a single axis 

2.     use the mouse wheel to edit and instantaneously move that axis 

Two to Five axis moves 
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1.     Edit the Target Position(s) of any axis of interest 

2.     Click the Drive All button to move to the new 5 axis position 

 

To be able collect data you need to choose the position on your sample. 

Positions: Add Analysis Positions on Platen Viewer images 

The platen(sample) should be on the Stage.  Analysis positions added to a Navigation Drawing 

or to an Intro station Navigation Photo will be assigned an analysis area at the time of they are 

created. 

1.     Create a new analysis position on the Navigation 

Drawing or Intro station Navigation Photo in the Platen Viewer 

Choose from the following options: 

o Right-click at the desired position location on the image and 

select Create [Point] 

o Click on the Define Point icon at the top of the Platen Viewer 

L-Click at the desired position location on the image 

Note: Multiple positions can be created while one of the “Define” icons is 

selected 

Note: Return control to the Zoom icon in the Platen Viewer toolbar when 

this task is completed 

3.     Create a new analysis position at the “Current Stage Position” 

o With the Stage Marker on the Platen Viewer at the desired location; 

Right-click over the Stage Marker and select Create Stage [Point, Area, 

Line, HP] 

Note: A position will be added to the Platen Viewer and to the Position List Table 

Refer to VersaProbeII manuals if you need to analyze area with preset dimensions such as 

Area, Line or HP. 

 

XPS: Setup Charge Neutralization for Acquisitions 

Charge neutralization will be used for any new acquisition if the Auto Neutralization is setup in 

the XPS>Application>AcquisitionProperties>Setup window. 

Method 1 
1.     Open the XPS>Application>AcquisitionProperties>Setup window. 

2.     Select Auto[A] for E-Neut Auto Neutralization and/or Ion Gun Auto Neutralization 

3.     Select desired E-Neut Setting from the corresponding combo box  

and/or the desired Ion Gun Setting from the corresponding combo box 
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4.     Select Source Tolerance Required (Enabled) for the E-Neut if the acquisition starting 

should be dependant on whether the E-Neut’s emission is in tolerance 

5.     Close the XPS>Application>AcquisitionProperties>Setup window 

All subsequent acquisitions will perform an automated neutralization of the platen(sample) 

until the Auto Neutralization is set to Off 

Method 2 
1.     Right-click on the E-Neut Status box at the bottom of SmartSoft 

 

2.     Select E-Neut Auto Neutralization: Auto[A] 

3.     Right-click on the Ion Gun Status box at the bottom of SmartSoft 

 

4.     Select Ion Gun Auto Neutralization: Auto[A] 

All subsequent acquisitions will perform an automated neutralization of the platen(sample) 

until the Auto Neutralization is set to Off 

1 XPS: Z-Align at a Position Before Acquisitions 

Z-Align can be performed automatically at each position in the Position List before each 

acquisition.  Each position’s Z height will be updated with the Z-Align’s calculated height. 

1.     Open the XPS>Application>AcquisitionProperties>Setup window. 

2.     Select Z-Align Enabled in the Z-Align Before Acquire section 

3.     Select the desired X-Ray Setting and desired X-Ray Setting (High Power) from the 

corresponding combo box 

4.     Close the XPS>Application>AcquisitionProperties>Setup window 

All subsequent acquisitions will perform an automated Z-Align of the platen(sample) until 

the Auto Z-Align is set to Disabled 

2 XPS: Presputter at a Position Before Acquisitions 

Presputter can be performed automatically or manually with the Ar Ion Gun or with the 

optional C60 or GCIB ion guns. 
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Automated Method 
1.     Open the XPS>Application>AcquisitionProperties>Setup window. 

2.     Select Presputter Enabled in the Presputter Before Acquire section 

3.     Select the desired Ion Gun Type from the combo box 

4.     Select the desired Ion Gun Setting from the Presputter Setting combo box 

5.     Set Zalar to the desired Enabled or Disabled setting 

6.     Select the desired Presputter Time(min)  

Note: The Presputter Depth Angstrom field will indicate the corresponding sputter depth 

if this Ion Gun setting has a calibrated sputter rate parameter 

7.     Close the XPS>Application>AcquisitionProperties>Setup window. 

All subsequent acquisitions will perform an automated presputter of the platen(sample) until 

the Presputter is set to Disabled 

Manual Method 
1.     Move the platen(sample) to align the area to be sputtered and perform a SXI-Z-Align 

2.     Open the Hardware>”Desired”Ion Gun window. 

3.     Load a desired sputter setting 

4.     Select the desired Sputter Time(min) in the Timed Sputter section  

Note: The Sputter Depth Angstrom field will indicate the corresponding sputter depth if 

this Ion Gun setting has a calibrated sputter rate parameter 

5.     Click the Timed Sputter button or the Timed Sputter w/Zalar button to start. 

Note: Sputter time will be displayed within the Timed Sputter button. 

Note: Click this button to abort the timed sputter 

 

XPS Survey: Acquire Data 

An XPS Survey is a quick, high-sensitivity acquisition of XPS data over a wide energy 

range.  An XPS Survey scan is used to identify which elements are present in the analysis 

area.  This is typically the first step in any sample analysis, providing an overview of elements 

present that will guide the design of the remaining analysis session. 

An XPS Survey involves acquisition of one spectrum from a quick, high-sensitivity scan of a 

wide energy range (typically 1100 to 0 eV in 1 eV steps, at 20 milliseconds/point) to survey the 

elements present at a point or area on the sample.  The highest Pass Energy (187.85eV) is used 

to maximize elemental sensitivity and not chemical sensitivity (energy resolution).  

Another part of the analysis strategy for survey spectra is to use the largest diameter X-

Ray probe that is possible, while confining the analysis to the feature of interest.  With the 

Monochromatic   -Ray source, X-Ray power increases linearly as the diameter of the X-Ray spot 

increases.  Time is also a variable in the survey experiment.  However, the quality of the 

spectrum increases as the square root of time, so it is very desirable to optimize the other 

parameters first. 
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It is assumed that the platen(sample) is in the analysis chamber (Intro Session) and that analysis 

positions and analysis areas have been defined (Sample Session). 

1.     Select the desired Active analysis positions in the Sample>Position List Table. 

2.     Enable the Auto Z  Before Acquire (XPS>Properties>Setup) if the analysis positions 

have not been previously aligned 

3.     Enable the Automated Neutralization (XPS>Properties>Setup  or Status Bar) if the 

sample is insulating 

4.     Open the XPS Spectrum Application window. 

5.     Optional use of Spectrum Settings 

a)     Select a setting from the Spectrum Settings combo box. 

b)     Click the Load button. 

6.     Optional use of Previous Acquisition file Spectrum Settings 

a)     Click the File… box. 

b)     Choose a Spectrum file with desired settings. 

c)     Click Open.  The Spectrum Parameters will update with the acquisition file settings. 

7.     Select the Source type from the combo box. 

8.     Select an X-Ray Setting picking the largest diameter X-Ray probe that is possible, while 

confining the analysis to the feature of interest. 

9.     Set the Pass Energy to 117.4 

10.  Add the Su1s Region to the Region List and set the Active boxes so only 

this Region is Active 

11.  Use the recommended 20ms Time Per Step (ms) 

12.  Select the number of Cycles to provide a data collection time of 

1-3 minutes [Acquisition Tim (min)] for larger diameter X-Ray spots  

or 5-15 minutes [Acquisition Tim (min)] for smaller diameter X-Ray spots. 

For example, an acquisition range of 1100 to 0eV, 1 sweep, 117.4PassEnergy, 1 eV/step and 

20 ms/point, set for 13 Cycles, will result in a data collection of ~10 minutes [Acquisition 

Tim (min)]. 

13.  Click the Start button in the Spectrum tab. 

o      The Queue: Acquire Spectrum-1 box appears displaying progress of 

the job and the Acquisition Status box appears displaying progress of the 

acquisition and the Remaining Time in the acquisition. 

 



27 | P a g e  
 

o One file will be saved with multiple traces [one for each analysis area] 

o The Filename will be: 

 <filename>. <file number>.<platen name>. <position #>. <position list 

name>.spe 
o The  SmartSoft-VersaProbe data will be displayed in the Spectral 

Viewer.  A Su1s Region will be displayed with a separate trace for multiple 

analysis areas.  

o All Active analysis positions in the Position List Table that are assigned a 

valid analysis area for the current acquisition will be visited sequentially. 

o To Stop or Abort the acquisition before all Cycles are completed, use 

the Stop button within the Queue: Acquire Spectrum-1 window. 

 
If the acquisition has started, then the following window will appear: 

 
o Stop button terminates data acquisition at the completion of the 

current Sweep and saves the data file. 

o Abort button terminates the acquisition immediately and eliminates the data file 

that was created. 

o Continue button will return to the current acquisition 

 The following window will appear: 

 
 Continue button will advance to the next Position List position of the 

current Job and repeat the acquisitions process. 

 Stop All button will advance to the end of the current Job and stop the 

acquisitions process. 

XPS Survey: Acquire More 

The platen(sample) must be at the same analysis position and no XPS parameters should have 

been changed.  Survey should be the last acquisition that was Stopped or 

completed.  Any Inactive Regions from the Survey acquisition will be removed from 

the Region List when the More acquisition is started. Auto Neutralization and Beam Park will 

be supported.  Pre-sputter and Z-Align will not be repeated. 

1.     Click the More button in the Spectrum tab to add additional data to the Stopped or 

completed Survey. 



28 | P a g e  
 

2.     Add more Cycles to increase the Analysis Time 

Note: If the Survey was stopped; the current number of Cycles can be used to continue 

the Survey 

3.     Click the Start button 

 The original acquisition file will be preserved with its previous name. 

 One new file will be saved with multiple traces [one for each analysis area] 

The new Filename will be: 

<”previous name”><+1>. spe 

 Subsequent More acquisitions will preserve previous files; acquire new data 

and save a new file with the Filename: 

<”previous name”><+2>. spe 

XPS Survey: Data Reduction in SmartSoft-VersaProbe 

Refer to the Multiplex subsection for information on displaying data, smoothing data, 

identifying peaks, annotating peaks and copying/printing the depth profile using the toolbar 

buttons in the XPS output area. 

XPS Survey: Data Reduction in MultiPak 

After collecting the survey spectra, open the MultiPak software to reduce the 

data.  The MultiPak Spectrum window and Periodic Table will appear.  For detailed 

information about the use of MultiPak, refer to the MultiPak Software Manual. 

1.     Click the LastAcq button (which will open the file most recently acquired) or click 

the File button on the upper tool bar to open the file of choice from a File selection menu. 

 The filename is displayed in green, indicating that this data is 

“selected.”  Any MultiPak functions activated will be performed on this data. 

 The header (displayed only when Header in the View menu is checked) lists the file’s 

data acquisition parameters (date of acquisition, beam voltage of acquisition, etc.). 

 The third line of the header will be updated with a processing history as data 

reduction routines are applied to the data. 

2.     Click the PeakID button to identify and label the peaks in the spectrum.  This will: 

 Perform an automatic charge correction based on the position of the C1s peak. 

 Search its database to identify and label the peaks. 

 Create a push button for each element in the Region bar at the bottom of 

the Spectrum window.  

  

3.     Verify the accuracy of the labels using your experience and the Handbook of X-ray 

Photoelectron Spectroscopy, which is available from Physical Electronics.  If mistakes 

were made, you can correct them with one or more of the software tools available.  

 To remove a label, click on it and drag it outside the window using the left mouse 

button or turn OFF the element in the MultiPak Periodic Table by toggling it off 

with the left mouse button.  
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 To label a peak or element that was missed by the Auto PeakID routine, you can turn 

that element ON in the Periodic Table by clicking the button for it.  This method will 

also create a pushbutton at the bottom of the Spectrum window for that new element. 

 If you do not know the identity of an unlabelled peak, you can manually search 

through the database of labels.  

a)     Using the middle or right mouse button, click on an open area of the spectrum.  This 

will display a cursor and list ESCA transitions that occur at the current cursor 

location.  

b)     While still holding down the mouse button, you can drag the cursor and search 

around the area of the unknown peak to see what elements occur in that energy 

range.   

Note: If you use the right mouse button for this operation, releasing the mouse button 

places the current label on the display at the location of the cursor.   

Note: If using the middle mouse button, when you release the mouse button, no 

labeling will take place.   

Note:  When labeling peaks in this manner, no buttons for the associated elements 

will be created at the bottom of the window.  If you want to add buttons for elements 

that were not identified by PeakID, you must create them by selecting the element 

from the Periodic Table. 

4.     Quantify Data in MultiPak.  Quantification of ESCA spectra is most accurate when Peak 

Area measurements are used.  In most situations, it is recommended that you use a Shirley 

Background Subtraction for making the area measurement.  

a)     To view or change the end points that will be used to define the background subtraction 

for a specific elemental peak, click the button at the bottom of the Spectrum window for 

that element and the software will automatically expand the region for that element’s 

default peak and display the cursors that are used for background subtraction.  If it is 

necessary to adjust the cursors, click and drag the cursor using the left mouse 

button.  While the cursor is being moved, a line depicting the background will be 

displayed to assist you in positioning the cursor.  

Note: The default peak is defined in the Transition Editor menu and, usually, it is the main 

or major elemental peak.  If you want to change the default peak, you can do so in this menu. 

Multiplex: Acquire Data 

A multiplex is a set of spectra from a series of high-resolution acquisitions of narrow energy 

ranges (typically 30 eV in 0.5 eV steps at 20 ms/point).  This type of acquisition yields great 

sensitivity and spectral detail in a short analysis time because only selected energy regions 

expected to contain XPS peaks of interest are scanned.  A multiplex acquisition is useful 

primarily when looking for trace elements.  As many as 20 elements can be acquired in one 

multiplex. 

The more commonly used multiplex acquisition routines are the window Line scan and Depth 

Profile (refer to VersaProbeII manuals).  This subsection describes the 

basic Multiplex acquisition routine. 
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A narrow energy range allows you to optimize either spectral detail or sensitivity, while keeping 

the data collection time short.  

To optimize spectral detail, a low Pass Energy is chosen (typically, 23.5 – 58.7eV) and the 

number of data points is increased (0.05 - 0.2eV/step).  There is a temptation to select a very 

low Pass Energy and a very small step size to obtain the “best” data.  In practice, it is necessary 

to make a compromise choice between the experiment time, Pass Energy, and data step 

size.  For an efficient, high-energy resolution experiment, you should use as high of a pass 

energy as possible, while still resolving the spectral features of interest.  You may also want to 

include the fewest number of data points possible while recording an accurate shape of the 

spectrum.  

To optimize elemental sensitivity, a high Pass Energy should be chosen (typically, 93.9 to 

117.4eV) and the number of data points is reduced (0.2 to 0.4eV/step).  Since sensitivity 

increases almost linearly with Pass Energy, it is most advantageous to use as high of a Pass 

Energy as possible. 

Use this customization capability to optimize an experiment. For example, if you would like 

high-resolution spectra of a few major elements, you can select a Pass Energy of 23.5eV for 

those elements.  For minor elements where the interest is sensitivity and quantification, you can 

select a Pass Energy of 117.4eV.  The MultiPak data reduction software is capable of reducing 

data files that have mixed Pass Energy and providing correct quantitative results.  

The required data acquisition time will depend on: 

 The quantity of the element present in the analysis area 

 The Pass Energy 

 The X-Ray spot size. 

The data acquisition time may vary from a few minutes per element to 30 minutes per 

element.  The Analysis Time (min) displayed in the Spectrum menu is the total time for all 

elements selected.  

The following procedure assumes that the Multiplex acquisition is following an 

initial Survey acquisition, and that analysis areas or points have been defined.  Otherwise, verify 

that the platen(sample) is in the analysis chamber (Intro Session) and that analysis positions and 

analysis areas have been defined (Sample Session). 

1.     Select the desired Active analysis positions in the Sample>Position List Table. 

2.     Enable the Auto Z  Before Acquire (XPS>Properties>Setup) if the analysis positions 

have not been previously aligned 

3.     Enable the Automated Neutralization (XPS>Properties>Setup  or Status Bar) if the 

sample is insulating 

4.     Open the XPS Spectrum Application window. 

5.     Optional use of Spectrum Settings 

a)     Select a setting from the Spectrum Settings combo box. 

b)     Click the Load button. 
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6.     Optional use of Previous Acquisition file Spectrum Settings 

a)     Click the File… box. 

b)     Choose a Spectrum file with desired settings. 

c)     Click Open.  The Spectrum Parameters will update with the acquisition file settings. 

7.     Select the Source type from the combo box. 

8.     Select an X-Ray Setting picking the largest diameter X-Ray probe that is possible, while 

confining the analysis to the feature of interest. 

9.     Select a Pass Energy and Time Per Step (ms) combination that meets your needs.  (Refer 

to the Pass Energy discussion in the previous paragraphs.)  

Note: The Pass Energy [Default] in the Spectrum Parameters area will set the Pass 

Energy for all current and new Regions 

Note: Unique Pass Energy settings can be applied for each Region using the Pass Energy in 

the Region Table area 

10.  Select Regions for analysis. 

Selecting Elements Using the Periodic Table 

Click the Period Table tool to select elements for analysis.  Click the button for each 

element to be analyzed in the Element Table.  This will define a narrow energy range for 

the most commonly used peak for each element 

Selecting Elements Using the Import Elements Tool 

Click the Import Elements tool to select elements for analysis.  This brings up 

the Import Element box.  Click the desired button to import elements used in 

previous Profile, Angle, Line or Map acquisitions. Selecting the Import Spectral 

Display will import elements identified in the “highlighted “Spectral Viewer [elements 

identified with Peak ID] 

11.  Select a number of Sweeps for each Region.  Define a higher number of Sweeps for 

elements that are present at lower concentrations to optimize the acquisition. 

12.  Customize the setup of each Region if desired.  Modify the energy range of an element or 

change the Pass Energy of a specific element. 

Note: To see the entire table without using the scroll bar, click the Show Table Details icon 

in the table toolbar; this brings up the Multiplex Regions window. 

Note: See the Region List Overview discussion for more details if needed. 

13.  Select the number of Cycles to provide a data collection time of 

1-3 minutes [Acquisition Tim (min)] for larger diameter X-Ray spots  

or 5-15 minutes [Acquisition Tim (min)] for smaller diameter X-Ray spots. 

14.  Click the Start button in the Spectrum tab. 

 The Queue: Acquire Spectrum-1 box appears displaying progress of the job and 

the Acquisition Status box appears displaying progress of the acquisition and 
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the Remaining Time in the acquisition. 

 
 One file will be saved with multiple traces [one for each analysis area] 

 The Filename will be: 

 <filename>. <file number>.<platen name>. <position #>. <position list 

name>.spe 

 The  SmartSoft-VersaProbe data will be displayed in the Spectral 

Viewer.  Each Region will be displayed within the viewer; with a separate trace for 

multiple analysis areas. 

 All Active analysis positions in the Position List Table that are assigned a valid 

analysis area for the current acquisition will be visited sequentially.   

 To Stop or Abort the acquisition before all Cycles are completed, use 

the Stop button within the Queue: Acquire Spectrum-1 window. 

 
If the acquisition has started, then the following window will appear: 

 
 Stop button terminates data acquisition at the completion of the 

current Sweep and saves the data file. 

 Abort button terminates the acquisition immediately and eliminates the data 

file that was created. 

 Continue button will return to the current acquisition 

 The following window will appear: 

 
 Continue button will advance to the next Position List position of the 

current Job and repeat the acquisitions process. 

 Stop All button will advance to the end of the current Job and stop the 

acquisitions process. 

XPS Multiplex: Acquire More 
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The platen(sample) must be at the same analysis position and no XPS parameters should have 

been changed.  Multiplex should be the last acquisition that was Stopped or 

completed.  Any Inactive Regions from the Multiplex acquisition will be removed from 

the Region List when the More acquisition is started. Auto Neutralization and Beam Park will 

be supported.  Pre-sputter and Z-Align will not be repeated. 

1.     Click the More button in the Spectrum tab to add additional data to the Stopped or 

completed Multiplex acquisition. 

2.     Add more Cycles to increase the Analysis Time 

Note: If the Multiplex acquisition was stopped; the current number of Cycles can be used to 

continue the acquisition 

3.     Click the Start button 

 The original acquisition file will be preserved with its previous name. 

 One new file will be saved with multiple traces [one for each analysis area] 

The new Filename will be: 

  <”previous name”><+1>. spe 

 Subsequent More acquisitions will preserve previous files; acquire new data and save 

a new file with the Filename: 

<”previous name”><+2>. spe 

XPS Multiplex: Data Reduction in SmartSoft-VersaProbe 

Data reduction and reporting can be performed in SmartSoft-

VersaProbe or MultiPak.  MultiPak allows for more advanced data reduction.  In many cases 

the SmartSoft-VersaProbe procedures will be sufficient. 

Spectral Display 

 Use the  Zoom to enlarge a region of interest and the Right-click Context 

menu; Fullscreen to revert back. 

 Select the  Show One. Use the  Current Curve to view a 

single Region. 

 Click the  Fullscreen button for a full screen view of the Spectral Viewer. 

Note: With Profile or Line or Map data displayed; use the  Fullscreen Data/Tile button 

to enlarge the highlighted file’s Spectral or Profile Viewer. 

Annotate the Spectral Viewer 

 Double-click within the viewer and type in text to annotate.  Click outside the text 

box to set the text. 

 To move the text, click and drag the text to the desired location. 

 To edit text, double-click over the text box, then edit.  Right-click over the text for 

more options (cut, copy, paste, delete, etc.). 

 Right-click over the viewer for additional options, including delete all 

annotation.  Click the Properties option to open the Graph Annotation 

Properties box.  Use this box to select the text font, size, color, etc. 



34 | P a g e  
 

Data Reduction 

 Use the  9 Point Savitsky-Golay Smooth to smooth the data. 

 Use the  Peak Identification to identify peaks 

 Use the  Energy Cursor to identify peaks 

 Use the  Element Cursor to identify peaks 

Output the Data 

 Click the   button to Copy the selected viewer to the clipboard.  This allows the data 

to be imported as a graphic into any Microsoft Office application (Word, PowerPoint, 

etc.).  

 Click the  button to Print the selected viewer to the default printer. 

o NOTE:  Annotation changes made to the viewer are not saved as part of the data 

file.  

XPS Multiplex: Data Reduction in MultiPak 

After collecting the Multiplex data, open the MultiPak software to reduce the 

data.  The MultiPak Spectrum window and Periodic Table will appear.  For detailed 

information about the use of MultiPak, refer to the MultiPak Software Manual. 

1.     Click the LastAcq button (which will open the file most recently acquired) or click the File 

button on the upper tool bar to open the file of choice from a File selection menu. 

 Initially, all the individual spectra will be displayed on one energy axis, and there 

will be a button for each element at the bottom of the Spectrum window (in 

the Region bar). 

 To view the spectrum of an individual element, click the button that represents the 

element. 

 The filename is displayed in green, indicating that this data is 

“selected.”  Any MultiPak functions activated will be performed on this data. 

 The header (displayed only when Header in the View menu is checked) lists the file’s 

data acquisition parameters (date of acquisition, beam voltage of acquisition, etc.). 

 The third line of the header will be updated with a processing history as data 

reduction routines are applied to the data. 

2.     Quantify Data in MultiPak.  Quantification of ESCA spectra is most accurate when Peak 

Area measurements are used.  In most situations, it is recommended that you use a Shirley 

Background Subtraction for making the area measurement.  

a)     To view or change the end points that will be used to define the background subtraction 

for a specific elemental peak, click the button at the bottom of the Spectrum window for 

that element and the software will automatically expand the region for that element’s 

default peak and display the cursors that are used for background subtraction.  If it is 

necessary to adjust the cursors, click and drag the cursor using the left mouse 

button.  While the cursor is being moved, a line depicting the background will be 

displayed to assist you in positioning the cursor.  
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Note: The default peak is defined in the Transition Editor menu and usually it is the main 

or major elemental peak.  If you want to change the default peak, you can do so in this 

menu. 

b)     Click the % button to view the results of the atomic concentration calculation. 

c)     To print the AC Table, open the File pull-down list on the AC Summary window and 

click Print 

3.     Chemical Information in MultiPak.  If the focus of the spectrum is to examine the peak 

shape and position of the spectra to obtain chemical shift information, there are several 

software tools in MultiPak to help you with that task.  Before reducing the data in a 

spectrum, a smoothing routine may be applied to the data set to improve the accuracy of peak 

position and peak area measurements.  A Savitzky-Golay Smooth routine is recommended 

because it retains the original shape of the data curve during the smoothing 

process.  Depending on the size of the data steps in your data and the width of the peaks, a 5-, 

7-, or 9-point smoothing operation is typically used.  To set up the 

preprogrammed Smooth button, which is displayed on the upper tool bar, 

click Data>Smooth/DerivativeSetup.  The Smooth/Derivative setup options will be 

displayed below the spectrum.  Using the left mouse button, select theSavitzky-

Golay Smooth and the desired number of points to be used for smoothing.  If you selected 

nine points, the Smooth button in the upper tool bar will read “SG9.”  The smoothing 

functions operate on the displayed data.  If all of the data regions are displayed, all of the 

regions will be smoothed.  If you click the Smooth button a second time, the data will be 

smoothed twice. 

4.     Energy Scale Calibration in MultiPak.  The first step in extracting chemical information 

from a peak is to correct the energy scale for any shifts that are due to charging.  Typically, 

this is done by looking at the position of the C1s peak from the hydrocarbon that is present 

on the surface of most samples.  If the C1s peak is not at approximately 284.8eV, it should be 

adjusted using the Shift routine.  

a)     To open the Shift routine, select Shift Setup from the Data pull-down list. 

b)     When a yellow cursor appears on the screen, position it with the left mouse button on 

the center of the hydrocarbon portion of the C1s peak.   

Note: When you release the mouse button, the C1s will shift to 284.8eV (or the position 

defined for C1s in your MultiPak Periodic Table database).   

Note: If no carbon is present on the sample, a peak from a matrix element with a known 

chemistry and binding energy may be used in place of the C1s to correct the energy scale 

for charge-induced shifts. 

Note: The energy can be read by positioning the cursor on the peak and reading the 

value on the right side of the lower Spectral Shift tool bar. 

5.     Binding Energy Identification in MultiPak.  The next step in extracting chemical 

information is to determine the binding energy of the peaks for each element.  This can be 

done in several ways.  

a)     With the peak displayed in the Spectrum window, position the cursor at the center of 

the peak, using the middle or right mouse button.  The location of the cursor is displayed 
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in terms of the binding energy and intensity at the right side of the lower tool bar in the 

Spectrum window.  

b)     The FWHM/Area Tool may also be used to determine the binding energy of a 

peak.  With the peak displayed in the Spectrum window, select 

the FWHM/Area function from the Tool pull-down list.   

The FWHM/Area Tool routine will automatically search for the most intense peak in the 

displayed data and display a list of information that describes the peak including its 

binding energy.  A yellow cursor is displayed where the software has determined the 

location of the peak to be.  If you want to change this position, grab the cursor using the 

left mouse button and drag it to the desired location.  When you have finished moving the 

cursor, the displayed information will be updated. 

6.     Curve Fit in MultiPak.  If the peak of interest contains more than one chemical state, it 

may be necessary to use the Curve Fit routine to determine the binding energy of each of the 

chemical states.  To perform a curve fit, use the following steps: 

a)     Make any necessary corrections to the energy scale using the Spectral Shift routine. 

b)     Click the Curve Fit button. 

c)     Deselect the Setup mode and adjust the energy cursors for background subtraction. 

d)     Select a Gaussian-Lorentzian peak shape.  (This peak shape is appropriate for 

most ESCA peaks.) 

e)     Define initial bands by pointing and clicking at the desired band position with the right 

mouse button. 

f)      Readjust the initial band estimates by entering numerical values in the Curve Fit 

Setup menu, or drag the flags attached to the currently selected band, using the left 

mouse button.  

g)     Click Fit to start the fitting routine. 

h)     Evaluate the resulting peak positions as shapes using your experience, reference spectra, 

and database information.  

i)      Make any necessary adjustments to the band parameters and click Fit again. 

j)      When you are satisfied with the results, print the Summary information and the curve 

fit spectrum. 

k)     Click Exit to leave the Curve Fit routine. 

Note: The error (in red) follows the baseline evenly, indicating a good fit. 

Note: The Curve Fit Summary table contains peak position information that can be used 

to determine the identity of the chemical state and peak area information to quantify 

those chemical states.  For a more detailed discussion of the Curve Fit software, refer to 

the MultiPak Software Manual.  

 

XPS Test Acquire 
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Perform a Test Acquire for each selected element.  Test Acquire provides an opportunity to 

determine whether the Acquisition Window Setup for each element is optimized. 

It is important to make each window wide enough to include the entire XPS peak.  Since Test 

Acquires can be performed only for the elements on the surface, the operator needs to consider 

the windows of the buried elements, especially on samples where there may be charging layers 

below the surface.  The windows need to be wide enough so that, if the sample charges and 

the XPS peaks shift upward in energy, the peaks will not move outside the acquisition windows. 

1.     Select the desired XPS Application tab. 

2.     Left-click to select an Element to examine (highlighting the Element “green”) 

3.     Click the  Test Acquire icon to launch the Test Acquisition 

 The Test Acquire window will open. 

 Test Acquire will provide a real-time display of data for a single Region that will not be 

saved.  

o The highlighted Region in the Region Table will be acquired in either a 

“Scanned” or “UnScanned” collection mode depending on the Analyzer 

Mode selected in the current application tab 

o The Sweeps and Ratio will default to a temporary value=1 

o The “Scanned” Time Per Step (ms) will default to a temporary value=10ms 

The “UnScanned” Time Per Region (s) will default to a temporary 

value=1000ms 

o The Persistence can be used to integrate more counts to improve the signal-noise 

The Test Acquire acquisition will continue until the  Stop button or the Acquisition 

Status Stop button is clicked. 

4.     Ensure that the full peak is contained within the analysis window.  Adjust the width or 

energy of the window to ensure that the peak remains within the window. 

 Adjusting any of the following parameters will stop and restart a new Test 

Acquire acquisition: 

Scanned 

Lower; Range; Upper; Analysis Lower; Analysis Upper: 
The Lower, Range and Upper parameters define the acquisition parameters for 

data collection for each Region.  

The Analysis Lower and Analysis Upper parameters define the analysis window 

that will be used in calculating the intensity data for each Region. 

UnScanned 

Peak; Range; Analysis Peak; Analysis Range: 
The Peak and Range parameters define the acquisition parameters for data 

collection for each Region.  

The Analysis Peak and Analysis Range parameters define the analysis window 

that will be used in calculating the intensity data for each Region. 
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Pass Energy [Pass]: 
The Pass Energy will define the analyzer band pass and resultant alignment of 

energies across the 16 channels. 

eV Step: 
The eV Step will define the energy resolution of the data file for each Region.  

 Selecting a new Element in the Region List will stop and restart a new Test 

Acquire acquisition. 

 Changing the Test Acquire Marker on the SXI viewer will stop and restart a new Test 

Acquire acquisition at the new scan position. 

 Select the Large Counts Display icon to reveal larger font size to the Max 

Counts readings. 

  

Queue Acquisitions Overview 

The Queue is available to generate a list of Jobs and to perform them sequentially as a single 

task.  These Jobs are added to the Queue from each of the five XPS Application tabs 

and Run from the Queue window.  It is required to have all of the analysis positions defined in 

the Sample>Position List Table and Add each Job to the Queue.  

Refer to each XPS Application instructions regarding acquisition setup.  Refer to the Acquire & 

Queue Overview (All XPS Applications) for further information regarding Queue features. 

1.     Right-click on the Add Q button on any XPS Application tab and select Clear Queue to 

begin. 

a)     Set the desired analysis positions to Active in the Sample>Position List Table. 

b)     Setup the desired XPS>Acquisition Properties for pre-acquisition and post-acquisition 

parameters. 

c)     Setup the desired XPS Application parameters 

d)     Click the Add Q button 

2.     Repeat steps a - d to add additional Jobs to the Queue 

3.     Right-Click the Add Q button and select Open Queue… on any XPS Application tab 

This will open the Queue window for viewing 

4.     Click the  Start button 

 The Queue: Acquisition Status window appears displaying progress of the 

acquisition and displaying the Remaining Time in the acquisition. 
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 Refer to each XPS Application instruction regarding viewer updates and file saving 

operations. 

 All Summary listed Active analysis positions in the Position List Table will be 

visited sequentially. 

  

Stopping or Aborting Tasks 
Use the Stop button to stop or abort acquisitions before they are complete. 

 Stop: 
Click the Stop button within the Queue:Acquisiton Status window or within 

the Queue window to stop or abort a current Task or Job. 

Clicking the Stop button will stop non-acquisition tasks such as SXI, Test 

Acquire, Platen Transfers, etc. 

Clicking the Stop button with an acquisition running will prompt the user to choose 

between Stop & save data, Abort & discard data, or Continue with the current Job. 

 

Once the acquisition is stopped or aborted a prompt will appear giving the user the choice 

of Continuing with other Positions/Jobs remaining in the Position List or Queue or to Stop 

All Jobs. 

 

  

Queue: Edit (Add, Delete, Change Order) 

1.     Open the Queue with the desired setting. User-1 or customized setting. 

Add 

1.     Verify that the desired Acquisition Properties are selected. 

2.     Verify that the desired acquisition parameters are selected. 

3.     Verify that the desired positions are Active in the Position List. 

4.     Click the Add Q button in an Application tab. 

This Job will be added to the end of the Job list 

Delete 
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1.     L-click to select the desired Job in the Queue>Job>JobList. 

Job will change to “green highlighted” 

2.     Click the Delete button in the Jobs toolbar. 

This Job will be removed from the Job list 

Change the Order of the Job list 

1.     L-click to select the desired Job in the Queue>Job>JobList. 

Job will change to “green highlighted” 

2.     Click the List Item Up or List Item Down button in the Jobs toolbar. 

This Job will be moved to a new order in  the Job list 

Queue: Run the Queue 

1.     Open the Queue. 

2.     Click the Start Queue button to run the entire Job list 

Queue: Run a Portion of the Queue 

1.     Open the Queue. 

2.     Right-click on a desired Job in the Job list and select Run From Here 

Queue: Stop the Acquisition and Continue at the Next Position 

1.     Click the Stop button within the Queue:Acquisiton Status window or within 

the Queue window to stop a current Job 

2.     Click the Stop button in the Acquisition Stop… window 

The acquisition will stop at the end of a break point [sweep, cycle, frame] 

3.     When the Acquisition is complete 

Click the Continue button in the Stop Complete window 

The current Job will continue at the next Position in the Position List 

Queue: Stop the Current Job and Continue at the Next Job 

1.     Click the Stop button within the Queue:Acquisiton Status window or within 

the Queue window to stop a current Job 

2.     Click the Stop button in the Acquisition Stop… window 

The acquisition will stop at the end of a break point [sweep, cycle, frame] 

3.     When the Acquisition is complete 

Right-click the Continue button in the Stop Complete window 

4.     Select Continue at Next Job from the list of options 

The Queue will continue at the next Job in the Job list 

Queue: Stop the Queue Completely 

1.     Click the Stop button within the Queue:Acquisiton Status window or within 

the Queue window to stop a current Job 
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2.     Click the Stop button in the Acquisition Stop… window 

The acquisition will stop at the end of a break point [sweep, cycle, frame] 

3.     When the Acquisition is complete 

Click the Stop All button in the Stop Complete window 

The Queue will turn off any neutralization and stop 

Queue: Abort the Acquisition and Continue at the Next Position 

1.     Click the Stop button within the Queue:Acquisiton Status window or within 

the Queue window to stop a current Job 

2.     Click the Abort button in the Acquisition Stop… window 

The acquisition will abort immediately 

3.     When the Acquisition is aborted 

Click the Continue button in the Stop Complete window 

The current Job will continue at the next Position in the Position List 

Queue: Abort the Current Job and Continue at the Next Job 

1.     Click the Stop button within the Queue:Acquisiton Status window or within 

the Queue window to stop a current Job 

2.     Click the Abort button in the Acquisition Stop… window 

The acquisition will abort immediately 

3.     When the Acquisition is aborted 

Right-click the Continue button in the Stop Complete window 

4.     Select Continue at Next Job from the list of options 

The Queue will continue at the next Job in the Job list 

Queue: Abort the Queue Completely 

1.     Click the Stop button within the Queue:Acquisiton Status window or within 

the Queue window to stop a current Job 

2.     Click the Abort button in the Acquisition Stop… window 

The acquisition will abort immediately 

3.     When the Acquisition is complete 

Click the Stop All button in the Stop Complete window 

The Queue will turn off any neutralization and stop 

Refer to VersaProbeII manuals about more Quene options. 

Some Analysis Considerations 

 Use as much current as possible for good signal-to-noise ratio while (1) still being able to 

resolve the features of interest (if the beam diameter is larger than the feature of interest, 

you will get substantial signal from the surrounding area) and (2) not causing electron 

beam damage to the sample surface. 



42 | P a g e  
 

 Differentiating data makes it easier to identify elements, because Auger peaks are riding 

on a high secondary electron background.  Smoothing data will lessen the impact of noise 

on the spectrum, but peak resolution is lost as the smoothing function broadens.  

 Survey spectra can be very noisy when rastering over an area that includes elements of 

drastically varying secondary electron yields or has rough surfaces with sharply changing 

angles.  

 Longer acquisition times or multiplex spectra are usually needed to identify minor 

elements.  

 Be aware of elemental sensitivity factors when choosing beam voltages.  As a general 

trend, as the beam voltage is increased, the sensitivity to high-energy Auger peaks 

increases while the sensitivity to low-energy peaks decreases.  

 Be aware of the four types of beam damage that the current selected can do to your 

sample:  

 Reduction—Metal oxides and hydrocarbons can be reduced by the electron beam. 

 Desorption—Adsorbed material can be removed.  

 Electron migration—Mobile ionic material can be repelled or drawn toward the electron 

beam.  For example, PSG glass contains phosphorus, which is attracted to the beam.  

 Diffusion—The beam’s heat can cause an intermixing of liquids, solids, and gases. 

 


